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NEW QUESTION 1

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have a query named Queryl that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved by the query is shown in the following table.

| UserMame | Userld | Location
Uzerl 1001 il
Liser] 1001 | Seattle
Userd 2 null
sar? 112 | S=attle
User 1002 | Montrea
[Jzord 1004 il

You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

UserMName | Userld Location |

Userl 1401 seattle
User? 1002 Seattle

[Jserd 1003 hontreal
Userd 10004 null

Usert 1005 rutl

Solution: You select the UserName and Location columns, and then you click Keep Duplicates. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 2

You install Microsoft Power Bl Publisher for Excel.

You need to use Excel to connect and analyze Power Bl data.

To which two types of Power Bl data can you connect? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. apps

B. datasets
C. reports

D. dashboard

Answer: BC

Explanation:

Analyze in Excel is very useful for datasets and reports that connect to Analysis Services

Tabular or Multidimensional databases, or from Power Bl Desktop files or Excel workbooks with data mo that have model measures created using Data Analysis
Expressions (DAX).

https://docs.microsoft.com/en-us/power-bi/service-analyze-in-excel

NEW QUESTION 3

You have a KPI named Goal that calculates the sales from the previous year and multiplies the sales by 1.1. You need to modify Goal to multiply the sales from
the previous year by 1.15.

What should you do?

A. From Power Pivot, modify the measure.

B. From the properties of the KPI, modify the KPI base field.

C. From Power Pivot, create a hew calculated column, and then modify the KPI.
D. From the properties of the KPI, modify the absolute value.

Answer: A

NEW QUESTION 4
You need to create a PivotChart as shown in the exhibit. (Click the Exhibit button.) Exhibit:
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Which field should you use for each area? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A
Explanation:
Legend: BrandName Axis: MonthName

NEW QUESTION 5
You have a query as shown in the following exhibit.

You need to ensure that the data only contains rows that have a valid date.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:
Change the column type of the Date Column Group rows by the Date column
Remove errors from the date column.

NEW QUESTION 6
You have an Excel workbook that contains a table named Sales. You add Sales to the Power Pivot model.
You need to set a column named TransactionlID as the row identifier for the Sales table. What should you do?

A. From Power Pivot, modify the Table Behavior setting.
B. From Query Editor, add an index column.

C. From Query Editor, modify the Data Type.

D. From Power Pivot, modify the Default Field Set.

Answer: A

Explanation:
https://msdn.microsoft.com/en-us/library/hh560542(v=sql.110).aspx

© |n the Data View of your PowerPivot Window, click the PowerPivot Window: Advanced Tab.
© Click the table tab at the bottom of the window to select the table for which you are configuring
properties.

©n Reporting Properties, click Table Behavior.

© Set the Row Identifier, and then proceed to specify other properties in this dialog.
Opening the Table Behavior dialog box https://ksdconsultancy.blog/2015/10/08/set-table-behaviour-in-powerpivot/

NEW QUESTION 7
You need to configure a PivotChart as shown in the following exhibit.
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Witch chart element should you enable?

A. Data Labels
B. Axis Titles
C. Data Table
D. Error Bars

Answer: B

NEW QUESTION 8

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.

You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)

Data Sample exhibit:
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The tables in the model contain the following data:

C DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue column.

C Workshops have a list of all the workshops and the current and previous workshop managers. The

format of the Workshop Manager column is always Firsthame Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the
record is the current workshop manager.

C RepairTypes has a list of all the repair types

© Dates has a list of dates from 2015 to 2018

End of repeated scenario.

You need to add a custom column to the workbook query for Workshops that contains the email address of the workshop manager. The format of the email
address is firstname.lastname@contoso.com.

How should you complete the query from Query Editor? To answer, select the appropriate options in the answer area.

I}IOITE: Each correct selection is worth one point.
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A. Mastered

B. Not Mastered

Answer: A
Explanation:
Text.Replace([Workshop Manager]," ",".")&Contoso.com
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NEW QUESTION 9
You have a data model that has the following tables.

Table name Column name
Sales Date
SalesAmount
Product
Date Date
Year
Month
Day
You create a PivotTable. The data displayed in the PivotTable is shown in the following table.
Row Labels Sum of SalesAmount % of Grand Total
2011 58,341,224 364 B3 100.00%
2012 S8 341,224 364 B3 100.00%
2013 S8.341.224 364 83 100.00%
2014 58,341,224 364 83 100.00%
2015 S8 341,224 364 B3 100.00%
2016 S8.341.224 364 83 100.00%
2017 58,341,224 364 83 100.00%
Grand Total 58.341.224.364.83 100.00%%

You need to ensure that the correct data is displayed. What should you do?

A. Modify the workbook connections
B. Configure the PivotTable Options
C. Modify the relationships

D. Refresh the data connection

Answer: C

NEW QUESTION 10

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have two Microsoft SQL Server database servers named Productionl and Testl. Productionl contains the same tables as Test1. but only a subset of the
data.

You add Testl as a data source, and you select 10 tables. You configure several transformations. You need to connect the model to the tables in Productionl. The
solution must maintain the existing

transformations.

Solution: You delete the existing queries, and then you add new data sources. Does this meet the goal?

A.yes
B. No

Answer: B

NEW QUESTION 10

You have an Excel workbook that has the following two workbook queries:

A query named consultants that retrieves a table named Consultants_Contact from a Microsoft SQL Server database
A query named employees that retrieves a table named Employee_Contact from a Microsoft Azure SQL database
Both tables have the same columns.

You need to combine all the data from Consultants and Employees into one table. Which command should you use?

A. Transpose

B. Append Queries
C. Merge Queries

D. Combine Binaries

Answer: B
Explanation:

Append is similar to UNION ALL in T-SQL.
http://radacad.com/append-vs-merge-in-power-bi-and-power-query

NEW QUESTION 11
You need to create a combo chart to display the count of orders by month and profit by month as shown in the exhibit. (Click the Exhibit tab.)
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How should you configure the combo chart? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Order Count:Stacked columnNo Profit:LineYes
http://www.excel-easy.com/examples/combination-chart.html
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NEW QUESTION 13

You have an Excel workbook that contains two tables named User and Activity. You plan to publish the workbook to the Power Bl service.

Users will use Q&A in the Power Bl service to perform natural language queries.

You need to ensure that the users can query the term employee and receive results from the User table. What should you do before you publish to Power BI?

A. From the Power Pivot model, edit the synonyms.

B. From PowerPivot Settings, modify the language options.

C. From PowerPivot Settings modify the categorization options.
D. From Workbook Connections, add a connection.

Answer: B

NEW QUESTION 16
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.

You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)

Data Sample exhibit:
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The tables in the model contain the following data:

c DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.

c Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.

C RepairTypes has a list of all the repair types

© Dates has a list of dates from 2015 to 2018

End of repeated scenario.

To the Dates table, you need to add a calculated column named Months Ago. Months Ago must display the number of calendar months before the current month.

For example, if the current date is July 10, 2017, the Value of Months Ago will be O for all the dates in July 2017, 1 for all the dates in June 2017, and 2 for all the

dates in May 2017.

How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

= (TODAY () ) -MONTH( [Date] )+ ( (YEAR | = ())y=[Yearj)=l2 }
CALCULATE DATE
DATEDIFF DATESYTD
MONTH DATEVALUE
YEAR TODAY

A. Mastered
B. Not Mastered
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Answer: A

Explanation:

Box 1: MONTH

Box 2: TODAY

References:

https://msdn.microsoft.com/en-us/library/ee634914.aspx https://msdn.microsoft.com/en-us/library/ee634567.aspx https://msdn.microsoft.com/en-
us/library/ee634554.aspx

NEW QUESTION 21
You have 12 sales reports stored in a folder as CSV files. Each report represents one month of sales data for a year. The reports have the same structure.
You need to analyze the entire year of sales data.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
 Actions. Anwweer Area
it the queny. and then cick Combine Binaries.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:
Click From CSV, and then select the first file in the folder. Edit the query, and then click Append Queries.
From the Power Pivot tab, click Add to Data Model.

NEW QUESTION 25

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have a Power Pivot model that contains the following tables.

Table name Column name
ProductlD
Products ProductMame
Price
ProductCategorvID
ProductCategory ProductCategorvID
ProductCategoryName

There is a relationship between Products and ProductCategory.

You need to create a hierarchy in Products that contains ProductCategoryName and ProductName. Solution: You create a calculated column that uses the
RELATED DAX function

Does this meet the goal?

A. Yes
B. No

Answer: A
Explanation:
References:

https://www.mssqltips.com/sqlservertip/2900/creating-hierarchies-in-powerpivot-for-excel/ https://msdn.microsoft.com/en-us/library/ee634202.aspx

NEW QUESTION 26
You have the following table named SalesOrder Detail in a model.
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You need to calculate the sum of SalesTotal for all the rows that have a quantity greater than 1.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
CALCULATE(SUMX('SalesOrdersDetail'[SalesTotal]),'SalesOrderDetail'[Quantity] > 1)

NEW QUESTION 29

You add two tables named Date and Invoices to a data model, Invoices contains a column named InvoiceDate that has a Data Type of Date, Date contains a

column named DatelD that has a Data Type of which Number. DatelD is in the format of YYYYMMDD.
You need to create a relationship between Date and Invoices. What should you do first?

A. Change the Data Type of InvoiceDate and DatelD to Text.

B. Create a measure in Invoices that uses the Format DAX Function.

C. Change the Data Type of DatelD to Date.

D. Create a calculated column in Invoices that uses the Format DAX function.

Answer: C
Explanation:

https://support.office.com/en-us/article/data-types-in-data-models-e2388f62-6122-4e2b-bcad-053e3da9ba90?ui=

NEW QUESTION 32
You have a query that retrieves the following data.

Vendor ID Quantity
110 10

110 10

110 3

110 5

111 3

111 2

111 3

112 1

112 1

113 10

You need to configure the query to ensure that the data appears as shown in the following table.

Vendor ID Quantity
110 30

111 g

112 2

113 10

What should you do?

A. From the Transform tab, use the sum function on the Vendor_ID column
B. Group by Vendor_ID and add a SUM aggregation

C. Unpivot the table on the Vendor_ID column

D. Pivot the table on the Vendor_ID column

Answer: B
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NEW QUESTION 34
You have a workbook query that retrieves data from a table named Users. Users contains a column named PhoneNumber. The following is a sample of the data in

PhoneNumber.
514 555 0169

1 (11) 500 555-0122

128 555-0148
819 555-0186
1-996-555-0192
+1 138-555-0156
556-555-0192

You need to create a custom column that contains the data in PhoneNumber in the format of 999-999-9999. The following is a sample of the desired data.

514-555-0160
500-555-0122
128-555-0148
819-555-0186
996-555-0192
138-555-0156
556-555-0192

How should you complete the Query Editor formula? To answer, drag the appropriate values to the correct targets. Each value may be used once, more than once,

or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Text.Replace(Text.End([Phone],12)," ","-")

il_l-'-&h - :'-ﬂ: [

oo it

NEW QUESTION 36
You have the Excel worksheet shown in the exhibit.
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You need to transform the data by using Query Editor. What should you do first?

A. From the Data tab, Click From Table/Range.
B. From the Insert tab, Click Store.

C. From the Data tab, Click Flash Fill.

D. From the Data tab, Click Consolidate.

Answer: A

Explanation:

Excel uses a dedicated Query Editor to facilitate and display data transformations. When you select Data > Get Data, then select the data source, such as a
workbook, or a database, the Navigator window appears so you can select which table (or tables) you want to use in your query. When you select a table, a
preview of its data is shown in the right pane of the Navigator window.
https://support.office.com/en-us/article/getting-started-with-get-transform-in-excel-2016-a8310388-2a12-438c-9

NEW QUESTION 38

You have 20 workbook queries that load 20 CSV files to a local computer.

You plan to send the workbook and the 20 CSV files to several users. The users will store the files in various location.

You need to ensure that the users can change the path to the CSV files in the queries as quickly as possible. What should you do from Query Editor?

. Merge all the querie

. Edit the source of the first query.

. Create a paramete

. Modify the source of each query to use the parameter.
For each query, create a new query that uses a referenc
Modify the source of each new query.

. Append all the querie

. Edit the source of the first query.

IOMmMOOw2

Answer: B

Explanation:
https://www.howtoexcel.org/power-query/how-to-parameterize-your-power-query/

NEW QUESTION 40
You have a date column named [Date] in the format of mm-dd-yyyy.
You need to create a column named Quarter that displays the yearly quarter. A sample of the desired data is shown in the following table.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

MONTH3

="Qtr " & ROUNDUP(MONTH([Date])/3,0)

="Qtr " & ROUNDUP(MONTH([Date])/3,0)
http://www.decisivedata.net/blog/quickly-create-week-month-quarter-and-year-fields-from-a-date-using-dax

NEW QUESTION 44
You have a workbook query that uses an Excel data source. The data source contains the following table.

You need the data to appear as shown in the following table.

How should you transform the data from Query Editor? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Answer Area
~
Columns to select:
User only
Userand UserlD
TestAScore, TestBScore, and TestCScore
- ~
Command to use:
Prvot Column
Reverse Rows
Unpivot Columns
A. Mastered

B. Not Mastered
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Answer: A

Explanation:

Box 1: User and UserID Box 2: Unpivot Columns

References:
https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9eal-49¢1-9d95-f588221¢7098

NEW QUESTION 47

You have a table in Power Pivot model that is loaded from a Microsoft SQL Server database.

The source table has four columns named ID, Price, Quantity, and Total. Total is derived by multiplying Price and Quantity. ID is a unique row identifier.

You need to minimize the amount of memory used to load the mode. The solution must ensure that you can create visualizations based on Price, Quantity, and
Total.

What should you do?

A. Replace the Total column by using a measure.

B. Replace the Total column by using a calculated column.
C. From Query Editor, remove duplicate rows from the table.
D. Move the Total column to a lookup table.

Answer: A
Explanation:
References:

https://support.office.com/en-us/article/create-a-memory-efficient-data-model-using-excel-and-the-power-pivot-

NEW QUESTION 49
You have a table named Sales that has three columns named OrderDate, OrderNumber, and SalesAmount. You need to create the PivotTable as shown in the
following table.

What should you use?

A. KPIs

B. sparklines

C. conditional formatting
D. banded rows

Answer: A

NEW QUESTION 52
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